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⼤綱
• Eclipse開發環境安裝設定

• 第⼀個App & ⽬錄說明

• Android Layout探討

• Activity探討

• UI使⽤注意事項

• 介⾯元件介紹實例
• 專案開發實例



開發環境安裝
• Step1 安裝Java Software Developer Kit (JDK)

• Java開發⼯具包

• Step2 安裝Eclipse (IDE)

• 開發環境
• Step3 安裝Eclipse外掛Android Developer Tools(ADT)

• ⽅便進⾏編輯、儲存、測試、除錯
• Step4 安裝Android軟體開發⼯具包(SDK)

• 提供完整Android API

• Step5 安裝模擬器 Android Virtual Device (AVD)



下載Java SDK
http://www.oracle.com/technetwork/java/javase/downloads/index.html

http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html


下載Android SDK
http://developer.android.com/sdk/index.html









SDK Tool安裝後記得資料夾，
之後設定需要



http://www.eclipse.org/downloads/index.php下載Eclipse

Windows

Mac



打開Eclipse，設定workspace



• Help > Install New Software

打開Eclipse，設定workspace，安裝ADT



http://dl-ssl.google.com/android/eclipse/

http://dl-ssl.google.com/android/eclipse/




• Preference >Android > SDK Location

設定Eclipse的Android SDK



若有miss的狀況> Open SDK Manager



安裝Android 4.0即可



Android ADT Bundle快速安裝





執⾏Eclipse



設定⼯作區



程式編輯區

檔案瀏覽

程式架構輔助視窗

其他輔助視窗

Eclipse環境



Tip: 顯⽰⾏號



⾃動完成 

or Alt+/



設定編碼為UTF-8



第⼀個App & ⽬錄說明



• File > New > Android Application Project

建立第⼀個專案



若是找不到 New > Android Project

Window > Customize Perspective
> Menu Visibility > File > New 
> Android Project



應⽤程式名稱
(iOS: Bundle Display 

專案名稱 

軟體名稱
(iOS:Bundle identifier)

最低需求版本

⽬標版本

編譯版本

版⾯



填入專案名稱



專案檔案⽬錄 程式編輯區

其他輔助視窗

專案建立結果



• src: 存放原始碼

• gen: ⾃動產⽣的檔案

• res: 相關資源檔案

• drawable: 影像圖型檔案

• layout: 版⾯配置檔案

• values: 使⽤資料值

檔案結構說明



專案名稱

src

gen

Android版本

assets

res

存放原始檔

⾃動產⽣的檔案, R.java

drawable

layout

values

Reference.  碁峰,Android初學特訓班

Android SDK可⽤類別

存放不產⽣索引的外部資源

存放圖片

存放界⾯設定的XML檔

存放參數設定的XML檔



• AndroidManifest.xml檔

• 紀錄應⽤程式的套件名稱、版本資訊、權限設定等屬性
• proguard.cfg檔

• 防⽌Android應⽤程式被反組譯

• project.properties檔

• 紀錄Android SDK版本資訊

• ic_lanucher-web.png

• 內定的icon檔

其他產⽣檔案



android程式進入點 onCreate(..)

package tw.com.airbridge.hello; //⽬前的class是在哪個package裡⾯, package有點像是資料庫

import android.os.Bundle; //將需要的class import進來

1

2
3

4

5

6

7

1

2

程式說明



public class MainActivity extends Activity

存取權限 class 類別名稱 extends ⽗類別
{
變數;
⽅法;

}

3

補充說明: Java宣告⼀個class的語法

4 Activity: ⼿機的基本畫⾯



5 @Override: 在android中，⽤來重寫⽗類別函式時使⽤

補充說明: @Override 重寫

• 重寫為物件導向概念中多型的表現，⽤來客制
化我們⾃⼰的需求



protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

}

6

補充說明: Java的⽅法宣告語法

存取權限 回傳值 ⽅法名稱 (參數)
{

..

.
}



protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

}

6

android程式進入點

初始化

指定顯⽰的layout為哪個檔案

Bundle類別： Intent之間，需傳遞的資料或參數可以藉由Bundle來傳遞



7 R.layout.activity_main

• R類別:  由系統⾃動產⽣的，⽤於統和所有的
資源，包括圖檔、layout、字串...



觀看Layout檔 activity_main.xml

圖像模式
⽂字模式

可以加入的元件



Layout檔 activity_main.xml的⽂字模式



使⽤Android的模擬器

• Window > Android Virtual Device Manager > New



模擬Android按鈕

使⽤電腦實體鍵盤

設定你的Android裝置



• Start > Launch

(我們的Android模擬裝置)



執⾏專案Hello

• 專案上按右鍵 > Run As > Android Application

(執⾏結果)



更改⼀下Hello World

屬性視窗圖⽰模式

點兩下



進入⽂字編輯模式

尋找string資源裡的hello_world這個變數對應到的字串



觀看string資源 res > values >strings.xml

<string name="hello_android">Hello Android!</string>



成功修改成Hello Android



android:layout_width=”wrap_content” ??



android的width or height常⽤的長度描述

• wrap_content: 指的是長度隨內容⽽
變

• match_parent: 指的是長度和⽗View
⼀樣

• fill_parent 和match_parent⼀樣
(Android 2.2以前的⽤法)



加入⼀個按鈕試試
       iOS: UIButton
Android: Button



改變元件?必須先知
道元件



    在Android中，元件可以透過唯⼀的id來取得，再指定到相
對的參考變數即可.

⽤findViewById(id)即可取得元件對應id的元件



Android如何反應動
作?



    在Android中，元件的動作有其各別提供的觸發⽅法
(Listener)，元件透過id取得後，再指定其⽅法即可



按按鈕來變更Hello⽂字

TextView設定id為textView1

辨識元件的第⼀步，指定id

(找到元件的id屬性)



package tw.com.airbridge.hello;

import android.os.Bundle;
import android.app.Activity;

//1. 要使⽤Button及TextView要先import其對應的class
import android.widget.*;

public class MainActivity extends Activity {

private Button myButton;
private TextView myTextView;

@Override
protected void onCreate(Bundle savedInstanceStateX) {

super.onCreate(savedInstanceStateX);
setContentView(R.layout.activity_main);

//2. 在取得contentView之後，可以透過findViewById取得元件，記得要轉型
myTextView=(TextView)findViewById(R.id.textView1); 
myButton=(Button)findViewById(R.id.button1);

}

}

取得對應id元件



package tw.com.airbridge.hello;

import android.os.Bundle;
import android.app.Activity;

//1. 要使⽤Button及TextView要先import其對應的class
import android.widget.*;

public class MainActivity extends Activity {

private Button myButton;
private TextView myTextView;

@Override
protected void onCreate(Bundle savedInstanceStateX) {

super.onCreate(savedInstanceStateX);
setContentView(R.layout.activity_main);

//2. 在取得contentView之後，可以透過findViewById取得元件，記得要轉型
myTextView=(TextView)findViewById(R.id.textView1); 
myButton=(Button)findViewById(R.id.button1);

}

}

//4. 指定Button在View被點擊時的動作
    private Button.OnClickListener myListener = new Button.OnClickListener(){

@Override
public void onClick(View v) {

myTextView.setText("ABC");

}

};

//3. 指定Button要執⾏的Listener
myButton.setOnClickListener(myListener);



執⾏結果



Layout探討



RelativeLayout



• 常為內建layout

• 依照相對關係排列
• 可攜度較差
• 盡量不要使⽤

使⽤時機





切換裝置後



LinearLayout



• 最常使⽤layout

• 可依照順序排列
• 可依照比例設定長度
• 缺點:無法重疊顯⽰

使⽤時機



Vertical Horizontal

LinearLayout

所有元件按照順序排列



巢狀的LinearLayout

垂直之中有⽔平



Example: LayoutClass

• 建立⼀專案名為LayoutClass

最後結果



內建為FrameLayout: 常⽤於畫⾯
切換，是⼀個畫⾯的容器，裡⾯
的View會重疊，依照顯⽰時間不

同出現View

變更為Vertical

Example: LayoutClass



變更前 變更後，元件可依序由
上⽽下排列



加入TextView1 ~ TextView3，並且變更

Layout結果 從屬性欄位的View>Background變



變更TextView2的寬度為match_parent

Layout結果，最寬的範圍和
parent View⼀樣



加入⼀個Horizontal的Layout



加入⼆個TextView到Horizontal 



Android的Layout差異性解決⽅案

• wrap_content、match_parent、fill_parent
是符合Android眾多不同Layout的⼀種⽅
式

• weight(權重比例)是另⼀種等比例縮放的
解決⽅式



變更TextView4的weight為2，TextView5的Weight為1

注意!!
當要依照比例改變的是寬度的

時候，



Exercise: 請完成如下Layout

weight:1

weight:1

weight:1

weight:2



TableLayout



• 對表格型態的layout很⽅便

使⽤時機



建立專案，改變Layout為TableLayout

按右鍵改變layout

改為TableLayout



改變layout時產⽣的多餘設定，造成layout有邊界

Delete!



TableLayout的元素TableRow
(其內的元素才可視為表格元素)



加入如下的排列



設定TableLayout的可延展屬性Stretch Columns=“*”
，平均分配欄位寬度



Stretch Columns=“0,2”的結果



多加⼀個TableRow，並加入⼀個Button



設定Button的layout_span=“3”

(顯⽰結果)



Exercise: 請完成以下Layout



FrameLayout



• 畫⾯需要重疊顯⽰時（例如使⽤說明）
• 不同時間出現不同內容（部分隱藏）

使⽤時機



新增專案exFrameLayout

• RelativeLayout > FrameLayout >刪除邊界設定



新增ImageView> 選擇ic_lancher圖片



Width=fill_parent, Height=fill_parent



加入⽂字，會顯⽰在左上⽅



設定TextView的Layout Parameters > Gravity > bottom|center



顯⽰結果

⽂字疊在圖片上⾯



View屬性有Visibility，可設定隱藏或顯⽰



• Activity的⽣命週期

• Intent

• Activity的⽣命週期實例

• Activity之間變數的傳遞(透過Intent)

Activity探討



程式進入點

每次都會執⾏



在各⼯作階段接入Log觀察



onCreate、onStart、onResume、onPause、onStop、
onDestroy

(透過界⾯直接列出想要的function)



Log.i(tag,msg);

(加入tag=”test”以及要顯⽰的訊息)



顯⽰⾃訂Tag的訊息

(Activity從開始到結束)



Exercise

• 練習追蹤Activity的⽣命週期



由Activity到Activity

id為button1



建立另⼀個Activity 
P2Activity.java

• File > New >Class

繼承⾃Activity

都不要勾選



private Button nextBtn;

@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
Log.i("test", "onCreate");
nextBtn=(Button)findViewById(R.id.button1);
nextBtn.setOnClickListener(btnListener);

}
OnClickListener btnListener= new OnClickListener() {

@Override
public void onClick(View v) {

// TODO Auto-generated method stub

}
};

在MainActivity加入Button相關的動作

執⾏

Intent nextIntent=new Intent(getBaseContext(), P2Activity.class);
startActivity(nextIntent);

Context 要被執⾏的class



<?xml version="1.0" encoding="utf-8"?>
<manifest xmlns:android="http://schemas.android.com/apk/res/android"
    package="com.example.activitytest"
    android:versionCode="1"
    android:versionName="1.0" >

    <uses-sdk
        android:minSdkVersion="14"
        android:targetSdkVersion="19" />

    <application
        android:allowBackup="true"
        android:icon="@drawable/ic_launcher"
        android:label="@string/app_name"
        android:theme="@style/AppTheme" >
        <activity
            android:name="com.example.activitytest.MainActivity"
            android:label="@string/app_name" >
            <intent-filter>
                <action android:name="android.intent.action.MAIN" />

                <category android:name="android.intent.category.LAUNCHER" />
            </intent-filter>
        </activity>

            </application>

</manifest>

<activity android:name="com.example.activitytest.P2Activity"> </activity>

AndroidManifest.xml加入新的Activity才可識別



執⾏結果



Exercise

• 練習追蹤多個Activity⽣命週期



為P2Activity加入對應的顯⽰畫⾯(View)



選擇LinearLayout，指定檔名為activity_p2



為activity_p2加入⼀個TextView

在P2Activity.java
onCreate裡加入layout名稱為

R.layout.activity_p2



(執⾏結果)



Activity之間變數的傳遞

Activity1 Activity2putExtra(“key”,value)

Intent it=getIntent()
XXX var=it.getXXXExtra(“key”)

startActivity(intent)



Activity之間變數的傳遞

Activity1

Activity2
startActivityForResult(intent,2)

Activity3

startActivityForResult(intent,3)

⽤onActivityResult(int requestCode, int resultCode, 
Intent data) 函⽰接收使⽤

⽤void finish()函⽰設定回傳內容



練習Activity之間的變數傳遞

• ⾸先更改Layout為LinearLayout



練習Activity之間的變數傳遞

• MainActivity加入go Page2及go Page3按鈕

• 新增P3Activity.java以及Layout: 
activity_p3.xml

• activity_p3.xml加入識別⽂字”This is 
Activity P3”，並加入顯⽰⽂字⽤於顯⽰
由MainActivity傳來的變數





Exercise

• 練習Activity變數傳遞與呼叫另⼀個
Activity



@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
Log.i("test", "onCreate");
Btn2P2=(Button)findViewById(R.id.button1);
Btn2P2.setOnClickListener(btnListener);

}

MainActivity.java

Btn2P3=(Button)findViewById(R.id.button2);
Btn2P3.setOnClickListener(btnListener); 注意!同⼀個Listener

OnClickListener btnListener= new OnClickListener() {

@Override
public void onClick(View v) {

{
Intent P2Intent=new Intent(getBaseContext(), P2Activity.class);
P2Intent.putExtra("name", "Hi Jimmy");
startActivityForResult(P2Intent, 2);

// startActivity(P2Intent);
}else if(v.getId()==R.id.button2)
{

Intent P3Intent=new Intent(getBaseContext(),P3Activity.class);
P3Intent.putExtra("name", "Hi Bill");
startActivityForResult(P3Intent, 3);

}

}
};

if(v.getId()==R.id.button1)

記得在AndroidManifest.xml加入此Activity



P3Activity.java

public class P3Activity extends Activity {

private TextView resulTextView;
@Override
protected void onCreate(Bundle savedInstanceState) {

// TODO Auto-generated method stub
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_p3);
resulTextView=(TextView)findViewById(R.id.textView3);

resulTextView.setText(nameString);
}

}

Intent getIntent=getIntent();
String nameString=getIntent.getStringExtra("name");



由P3Activity回傳資料



activity_main.xml

加入回傳顯⽰⽤字串



P3Activity.java 加入回傳字串
@Override
public void finish() {

// TODO Auto-generated method stub
Intent responseIntent=new Intent();

super.finish();
}

responseIntent.putExtra("response", "responsed from Bill");
setResult(RESULT_OK, responseIntent);

private TextView responseTextView;
..
responseTextView=(TextView)findViewById(R.id.textView1);
..

protected void onActivityResult(int requestCode, int resultCode, Intent data) {
// TODO Auto-generated method stub
super.onActivityResult(requestCode, resultCode, data);

if(requestCode==3)
{

if(resultCode==RESULT_OK)
{

String response=data.getStringExtra("response");
responseTextView.setText(response);

}
}

}

MainActivity.java 加入回傳判斷

(執⾏結果)



Exercise

• 練習由另⼀個Activity回傳資料



你已學會

• Android如何獲取View上的元件

• 如何設定動作
• Activity的⽣命週期

• Activity切換到另⼀個Activity

• Activity參數傳遞



Intent的其他應⽤

• 開啟網⾴
• 撥打電話
• 傳送簡訊
• …

參考網站: YSL的程式天堂
http://ysl-paradise.blogspot.tw/2008/12/intent.html

http://ysl-paradise.blogspot.tw/2008/12/intent.html


開啟新專案並設定如下Layout



public class MainActivity extends Activity {

private Button myButton;
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
myButton=(Button)findViewById(R.id.button1);
myButton.setOnClickListener(new OnClickListener() {

@Override
public void onClick(View v) {

//開啟網⾴
Uri uri = Uri.parse("http://google.com");
Intent it = new Intent(Intent.ACTION_VIEW, uri);
startActivity(it);

}
});

}
}

設定Intent開啟網⾴

執⾏結果



public class MainActivity extends Activity {

private Button myButton;
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
myButton=(Button)findViewById(R.id.button1);
myButton.setOnClickListener(new OnClickListener() {

@Override
public void onClick(View v) {

//叫出撥號程式
Uri uri = Uri.parse("tel:0800000123");
Intent it = new Intent(Intent.ACTION_DIAL, uri);
startActivity(it);

}
});

}
}

設定Intent呼叫撥號程式

執⾏結果



public class MainActivity extends Activity {

private Button myButton;
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
myButton=(Button)findViewById(R.id.button1);
myButton.setOnClickListener(new OnClickListener() {

@Override
public void onClick(View v) {

//叫起簡訊程式  
Intent it = new Intent(Intent.ACTION_VIEW);  
it.putExtra("sms_body", "The SMS text");   
it.setType("vnd.android-dir/mms-sms");  
startActivity(it);  
}

});
}

}

設定Intent傳送簡訊

執⾏結果



public class MainActivity extends Activity {

private Button myButton;
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
myButton=(Button)findViewById(R.id.button1);
myButton.setOnClickListener(new OnClickListener() {

@Override
public void onClick(View v) {
//路徑規劃

Uri uri = Uri.parse("http://maps.google.com/maps?
f=d&saddr=startLat%20startLng&daddr=endLat%20endLng&hl=en");  

Intent it = new Intent(Intent.ACTION_VIEW, uri);  
startActivity(it);  

}
});

}
}

設定Intent路徑規劃

執⾏結果(需要實機測試)



廣播Broadcast

• 可以監控某些事件的發⽣，並且做相對
應的處理

• 例如電池變化、撥號、系統進入等等
• 可以設定⾃⼰的狀態並且監控



廣播Broadcast
• 新增IntentFilter並設定監控Action

• IntentFilter.addAction可以增加監控Action

• 建立BroadcastReceiver

• onReceiver() 加入對應動作

• 監控的地⽅需註冊BroadcastReceiver

• 取消監控時要刪除BroadcastReceiver

• ⽤sendBroadcast送出⾃訂事件

• 也常⽤於跨Activity之間的資料傳遞



完成下列Layout

//新增BroadcastReceiver並且設定接收動作
myBReceiver = new BroadcastReceiver() {

@Override
public void onReceive(Context context, Intent intent) {

String action=intent.getAction();
String data=intent.getStringExtra("name");
if(action.equals("Br1Action"))

resultTxt.setText(data);

}
};

在onCreate()new ⼀個BroadcastReceiver
在onReceive()內判斷Action，並加入動作



btn1.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

Intent intent1 = new Intent("Br1Action"); //Br1Action為Action
intent1.putExtra("name", "hello1"); //加入key-value
sendBroadcast(intent1);

}
});

IntentFilter filter= new IntentFilter("Br1Action");
registerReceiver(myBReceiver, filter);

在onCreate()中新增IntentFilter並且註冊此動作

設定Button的動作，並且送出Broadcast



執⾏結果. 透過Broadcast修改TextView

@Override
protected void onStop() {

unregisterReceiver(myBReceiver);
super.onStop();

}

記得不⽤時要取消此BroadcastReceiver



Exercise: 跨Activity間透過Broadcast做資料傳遞

Activity1 Activity2

intent.getXXXExtra(“key”)

sendbroadcast(…..)

onReceive()

Activity3

Button

改變Activity1 的TextView

TextView



protected void onCreate(Bundle savedInstanceState) {
setContentView(R.layout.p3_activity);
btn=(Button)findViewById(R.id.button1);

btn.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

Intent intent1 = new Intent("Br1Action");
intent1.putExtra("name", "hello1");
sendBroadcast(intent1);

}
});
super.onCreate(savedInstanceState);

}

P3Activity.java

參考解答
//新增BroadcastReceiver並且設定接收動作

BroadcastReceiver myBReceiver = new BroadcastReceiver() {

@Override
public void onReceive(Context context, Intent intent) {

String action=intent.getAction();
String data=intent.getStringExtra("name");
if(action.equals("Br1Action"))

resultTxt.setText(data);

}
};

//要過濾的Action
IntentFilter filter= new IntentFilter("Br1Action");
registerReceiver(myBReceiver, filter);

MainActivity.java



• 主程序超過5秒沒有反應會錯誤

• 耗時的程式使⽤副程序操做
• 只有主程序Main Thread可以改變UI

• 副程序無法改變UI，但可透過Handler
改變UI

UI使⽤注意事項



主執⾏緒超時



做出以下Layout

public class MainActivity extends Activity {

private Button myBtn;
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
myBtn=(Button)findViewById(R.id.button1);

myBtn.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

//讓主線程Main Thread超過5秒
while(true)

;
}

});

}

}

按下按鈕後，跑無窮迴圈



執⾏結果，發⽣錯誤



使⽤副執⾏緒執⾏耗時程式
(使⽤Thread)



執⾏緒Thread

主執⾏緒

多個副執⾏緒



Thread使⽤⽅法 => 參數為Runnable物件

new⼀個Runnable物件

Runnable myTask=new Runnable() {

@Override
public void run() {

// TODO Auto-generated method stub

}
};



myBtn.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

Runnable myTask=new Runnable() {

@Override
public void run() {

while(true)
;

}
};
//將myTask Runnable物件交給Thread執⾏，注意！start才會執⾏
new Thread(myTask).start();

}
});

將原本的⽅法移到Runnable的Run裡⾯

start()執⾏



執⾏並不會發⽣錯誤



嘗試在副執⾏緒改變UI狀態



public class MainActivity extends Activity {

private Button myBtn;
private TextView myTxt;

@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
myTxt=(TextView)findViewById(R.id.textView1);
myBtn=(Button)findViewById(R.id.button1);
 
myBtn.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

Runnable myTask=new Runnable() {

@Override
public void run() {

// while(true)
// Log.i("test","xxx");

myTxt.setText("SSS");

}
};
//將myTask Runnable物件交給Thread執⾏，注意！start才會執⾏
new Thread(myTask).start();

}
});

}

按下Button改變TextView



竟然發⽣錯誤!!



程式看起來沒有
錯...編譯也沒有錯...



如何除錯?進入除錯模式



在可疑的地⽅連點兩下



• Project Name > Debug As > Android Application



執⾏到中斷點

進入Debug模式執⾏命令



執⾏到下⼀個中斷點

下⼀步，但不進入⼦程式

下⼀步，且進入⼦程式

從⼦程式跳開

執⾏命令說明



按下Button,直到第30⾏仍沒有錯





跑到不知名的程式檔內

發⽣錯誤!!



原來副Thread不能改變UI

Android為了考量安全性和執⾏效能，
不允許副執⾏緒直接更改主畫⾯的資料



主執⾏緒

副執⾏緒需要透過handler與主程序改變UI

Handler 改變UI
Thread



透過Handler從副執⾏緒改變UI



public class MainActivity extends Activity {

private Button myBtn;
private TextView myTxt;
private Handler myHandler=new Handler();
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
myTxt=(TextView)findViewById(R.id.textView1);
myBtn=(Button)findViewById(R.id.button1);
 
myBtn.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

Runnable myTask=new Runnable() {

@Override
public void run() {
//myHandler.post(Runnable), 將要執⾏的程式置於run()

myHandler.post(new Runnable() {

@Override
public void run() {

myTxt.setText("SSS");
}

});
}

};
//將myTask Runnable物件交給Thread執⾏，注意！start才會執⾏
new Thread(myTask).start();
}

});
}

執⾏結果

完整程式

參數為Runnable



可將Runnable視為⼀個task，為
Thread、Handler的參數



使⽤時機：主執⾏緒不能idle太
久 => ⼦執⾏緒 => 完成後改變UI



try {
  Thread.sleep(10000); //延遲10秒鐘

} catch (InterruptedException e) {
// TODO Auto-generated catch block

e.printStackTrace();
}

另⼀種延遲時間的⽅法Thread.sleep()

⼀樣造成crash

try… catch…(⾃動產⽣)
發⽣狀況時的處置



Exercise: 嘗試完成以下程式

按下按鈕, 更改⽂字從1~10



public class MainActivity extends Activity {

private Button myBtn;
private TextView myTxt;
private Handler myHandler=new Handler();
int i;
private Runnable countTask;
private Runnable updateUITask;
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

myTxt=(TextView)findViewById(R.id.textView1);
myBtn=(Button)findViewById(R.id.button1);
//定義countTask

//定義upadteUITask

myBtn.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

//執⾏此task
new Thread(countTask).start();

}
});

}
}

countTask = new Runnable() {
public void run() {

//延遲的動作在此task內做
try {

for(i=0;i<10;i++)
{

Thread.sleep(1000);
//每隔⼀秒透過Handler執⾏Update UI的⼯作
myHandler.post(updateUITask);

}
} catch (InterruptedException e) {

e.printStackTrace();
}

}
};

updateUITask = new Runnable() {

@Override
public void run() {

myTxt.setText(Integer.toString(i));

}
};

參考解答



Progress Dialog⽤法

• setTitle：設定Title

• setMessage：設定訊息

• setIndeterminate：是否無法判斷進度

• setCancelable：是否可以按返回键取消；

• show：顯⽰ProgressDialog。

• dismiss： 删除ProgressDialog



public class MainActivity extends Activity {

private Button myBtn;
private Runnable countTask;
private ProgressDialog pd;
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

   pd = new ProgressDialog(MainActivity.this);  
        pd.setTitle("Loading");   //設置標題  
        pd.setMessage("Please wait..."); //設置body訊息  
        pd.setCancelable(false); //設定不可點掉

myBtn=(Button)findViewById(R.id.button1);

//定義countTask
countTask = new Runnable() {

public void run() {
//延遲的動作在此task內做
try {

Thread.sleep(3000);
} catch (InterruptedException e) {

// TODO Auto-generated catch block
e.printStackTrace();

}
pd.dismiss();

}
};

myBtn.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

pd.show();
//執⾏此task
new Thread(countTask).start();

}
});

}
}

執⾏結果



..

..
pd.setProgressStyle(ProgressDialog.STYLE_HORIZONTAL); //設置進度條樣式
..
..

//定義countTask
countTask = new Runnable() {

public void run() {
//延遲的動作在此task內做
try {

for(i=0;i<100;i++)
{

Thread.sleep(100);
                pd.setProgress(i);

//每隔⼀秒透過Handler執⾏Update UI的⼯作
myHandler.post(updateUITask);

}
if(i==100)
{

pd.dismiss();
pd.setProgress(0);

}
} catch (InterruptedException e) {

e.printStackTrace();
}

}
};

//定義upadteUITask
updateUITask = new Runnable() {

@Override
public void run() {

myTxt.setText(Integer.toString(i));

}
};

執⾏結果

有進度條樣式



介⾯元件介紹

• TextEdit

• RadioGroup & RadioButton

• CheckBox

• Toast

• AlertDialog

• SharedPreferences



Example

• TextView提⽰，EditText輸入名字，
Button送出，⽤Toast顯⽰名字

• ⽤RadioGroup選擇年齡，⽤TextView顯⽰

• ⽤CheckBox選擇喜歡的食物並顯⽰

• 按下儲存鈕紀錄名字，⽤AlertDialog確定
並儲存



最後結果



1

2

3

• TextView : 提⽰

• TextEdit: 輸入名字

• Button: 按鈕送出

• Toast: 顯⽰名字

4

簡單介⾯練習



public class MainActivity extends Activity {

private Button myButton;
private EditText myEditText;

@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
myButton=(Button) findViewById(R.id.button1);
myEditText=(EditText)findViewById(R.id.editText1);
myButton.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

Toast.makeText(getBaseContext(), "your name is "+ myEditText.getText().toString() ,
                 Toast.LENGTH_LONG).show();

}
});

}
}

程式碼

匿名的Listener

使⽤Toast



• 常⽤屬性
• Input Type: 鍵盤型態

• MaxLength: 最多⽂字

• Lines: 最多顯⽰的列數

• Ems: 每列的字元數

• Editable: 可否編輯

EditText：作為輸入的元件

Edit可能的型態



• 使⽤⽅法：
• Toast.makeText(Context, 訊息, Time).show()

• Time

• Toast.LENGTH_LONG 較長時間

• Toast.LENGTH_SHORT 較短時間

• setGravity設定顯⽰位置

• Gravity.CENTER

• Gravity.BOTTOM

Toast：顯⽰訊息元件



多選⼀的
RadioButton 與RadioGroup

• RadioGroup裏的RadioButton中，只能選
擇⼀個

• 若沒有RadioGroup選項則⼿動加入

• 每個元件必定要有width及height

• 設定RadioGroup的Listener

• 在Listener中判斷選擇了哪個RadioButton





完成如下Layout並設定RadioGroup的⽂字



加入RadioGroup
找不到可以由XML檔直接加入

RadioGroup需要包
住RadioButton才可

管控



 <RadioGroup >
    <RadioButton
        android:id="@+id/radioButton1"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_below="@+id/editText1"
        android:layout_centerHorizontal="true"
        android:layout_marginTop="70dp"
        android:text="age 20~25" />

    <RadioButton
        android:id="@+id/radioButton2"
        android:layout_width="wrap_content"
        android:layout_height="wrap_content"
        android:layout_alignLeft="@+id/radioButton1"
        android:layout_below="@+id/radioButton1"
        android:text="age 26~30" />
</RadioGroup>



切換到Graphical Layout

出現許多錯誤

需要設定Width及Height



設定RadioGroup的id為myradio_group



加入年齡顯⽰的TextView



private Button myButton;
private EditText myEditText;
private RadioGroup myRadioGroup;
private RadioButton RBage20_25,RBage26_30;
private TextView ageTextView;

@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
myButton=(Button) findViewById(R.id.button1);
myEditText=(EditText)findViewById(R.id.editText1);
ageTextView=(TextView)findViewById(R.id.textView3); //顯⽰年紀的TextView

myRadioGroup=(RadioGroup)findViewById(R.id.myradio_group);
RBage20_25=(RadioButton)findViewById(R.id.radioButton1);
RBage26_30=(RadioButton)findViewById(R.id.radioButton2);

myRadioGroup.setOnCheckedChangeListener(new OnCheckedChangeListener() {

@Override
public void onCheckedChanged(RadioGroup group, int checkedId) {

switch (checkedId) {
case R.id.radioButton1:

ageTextView.setText(RBage20_25.getText().toString());
break;

case R.id.radioButton2:
ageTextView.setText(RBage26_30.getText().toString());
break;

default:
break;

}

}
});

設定變數

對應id元件

設定ChangeListener

以id判斷選到哪個
radioButton



執⾏結果

隨著選擇的RadioButton
改變



可多選的CheckBox

• CheckBox為多選項⽬

• 設定CheckBox.OnCheckedChangeListener

• ⽤isChecked判斷是否選取



加入CheckBox並更改名稱



//for checkbox
private CheckBox CBfood1,CBfood2;
private TextView likeTextView;
private String foodStr;
..
..
CBfood1=(CheckBox)findViewById(R.id.checkBox1);
CBfood2=(CheckBox)findViewById(R.id.checkBox2);
CBfood1.setOnCheckedChangeListener(cbListener);
CBfood2.setOnCheckedChangeListener(cbListener);
..
..
private CheckBox.OnCheckedChangeListener cbListener = new CheckBox.OnCheckedChangeListener() {

@Override
public void onCheckedChanged(CompoundButton buttonView, boolean isChecked) {

foodStr=“";  //清除內容

if(CBfood1.isChecked())
foodStr=foodStr+CBfood1.getText().toString();

if(CBfood2.isChecked())
foodStr=foodStr+CBfood2.getText().toString();

likeTextView.setText(foodStr);

}

};

CheckBox程式部分

同⼀個Listener

isChecked()判斷是否有
勾選



執⾏結果



加入Save按鈕，⽤AlertDialog確定是否寫入資料

加入⼀個Button



• 使⽤⽅法 AlertDialog.Builder(context)

• 常⽤屬性
• setTitle：設定顯⽰title

• setIcon：設定顯⽰圖片 

• setMessage：設定顯⽰訊息

• setPositiveButton：設定確定動作

• setNegativeButton：設定取消動作

• show：顯⽰

AlertDialog對話訊息



private Button saveButton;

//save
saveButton=(Button)findViewById(R.id.button2);

//確定儲存
saveButton.setOnClickListener(new View.OnClickListener() {

@Override
public void onClick(View v) {

new AlertDialog.Builder(MainActivity.this).setTitle(“寫入資料").setMessage("是否儲存")
                      .setPositiveButton("確定", new OnClickListener() {

@Override
public void onClick(DialogInterface dialog, int which) {

// 寫入資料

}
}).setNegativeButton("取消", new OnClickListener() {

@Override
public void onClick(DialogInterface dialog, int which) {

// TODO Auto-generated method stub

}
}).show();

}
});

AlertDialog程式部分

確定的動作

取消的動作



執⾏結果



使⽤SharedPreferences儲存資料

• 會以key-value的形式儲存

• 儲存⽅式
• 利⽤getSharedPreference(檔名,權限)取得物件

• 權限: MODE_PRIVATE(只有⾃⼰app可使⽤)

• Editor editor= SharedPreference物件.edit()

• editor.putXXX(key,value)

• 結尾要加.commit();

• 讀取⽅式
• 利⽤getSharedPreference(檔名,權限)取得物件

• ⽤SharedPreference物件.getXXX(key,內定值)取得資料



按下save鈕時，儲存姓名，在
下次進入畫⾯時直接帶出姓名

Exercise



離開App重新進入

Save後按Home鍵離開

找到App再點App進入



名字⾃動帶入



//下次進入時讀取
@Override
protected void onResume() {

SharedPreferences pref=getSharedPreferences("savename", MODE_PRIVATE);
String nameString=pref.getString("name", "");
myEditText.setText(nameString);
super.onResume();

}
..
..
new AlertDialog.Builder(MainActivity.this).setTitle("寫入資料").setMessage("是否儲
存").setPositiveButton("確定", new OnClickListener() {

@Override
public void onClick(DialogInterface dialog, int which) {

// 寫入資料
SharedPreferences pref=getSharedPreferences("savename", 

MODE_PRIVATE);
Editor editor=pref.edit();
editor.putString("name", myEditText.getText().toString());
editor.commit();
myEditText.setText(""); //寫完後清除EditText資料

}
})

參考解答



Example: 背景播放⾳樂

• Service

• Spinner選擇⾳樂

• 播放⾳樂



• Service本⾝不具有畫⾯，⽤於背景執⾏如⾳樂、
網路通訊

• 可以透過Handler或Broadcast與Activity溝通

• ⽣命週期為onCreate => onStart => onDestroy

•

Service服務說明



專案開發實例  
                 雲端書城





此專案將學習...

• 圖片載入(ImageView)

• 圖片滑動變換 (利⽤ViewFlipper)

• ListView 

• ListView Cell⾃定layout

• ListView Cell傳遞資料並加入動作

• OpenSource使⽤ (網路交涉)

• 網路圖片非同步載入



• http://goo.gl/iwnL4Y
下載使⽤資料

3張圖以及2個opensource

http://goo.gl/iwnL4Y


在activity_main.xml裡加入ImageView元件

新建專案LoadImage



Graphical Layout
Text Mode

圖片來源



如何從程式加入圖片

使⽤setImageResource



protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

myImageView=(ImageView) findViewById(R.id.imageView1); //取得圖片id

}

(執⾏結果)

透過setImageResource指定圖片來源

myImageView.setImageResource(R.drawable.ic_launcher);



針對不同size的drawable

hdpi : ⾼解析度【WVGA (480x800),FWVGA (480x854)】
mdpi:中解析度【HVGA (320x480)】
ldpi: 低解析度【QVGA (240x320)】



加入⾃⼰的圖片

1. 建立⼀個drawable的資料夾(共⽤)
2. 拖入檔案



建立字串陣列

private String[] imagePics={"news1","news2","news3"};
⽅式1: 直接新增

⽅式2: 透過資源取得

<?xml version="1.0" encoding="utf-8"?>
<resources>

    <string name="app_name">loadImage</string>
    <string name="hello_world">Hello world!</string>
    <string name="action_settings">Settings</string>
    
    

</resources>

<string-array name="newsImageNames">
        <item >"news1"</item>
        <item >"news2"</item>
        <item >"news3"</item>
        
    </string-array>

在values的strings中加入string-array

imagePics= getResources().getStringArray(R.array.newsImageNames);



Exercise 
Activity1按按鈕+傳參數 

Activity2顯⽰圖片

Activity1

Btn1

Btn2

Activity2

picture

news1.jpg

news2.jpg



容易犯的錯
• Page2的setContentView加入了嗎?

• setContentView的順序錯了嗎?

• 元件取得了嗎?

• AndroidManifest.xml加入新的class名稱了
嗎?

int id = getResources().getIdentifier("com.example.loadimage:drawable/" + imageFilename, null, null);

myImageView.setImageResource(id);

Tip: ⽤變數動態取得資源



protected void onCreate(Bundle savedInstanceState) {
// TODO Auto-generated method stub
super.onCreate(savedInstanceState);

myImageView=(ImageView) findViewById(R.id.imageView1); //取得圖片id
Intent myIntent=getIntent();
String imageFilename=myIntent.getStringExtra("filename");

 myImageView.setImageResource(id);

setContentView(R.layout.activity_show_image);

//利⽤資源getResources取得圖檔，不⽤加上副檔名
 int id = getResources().getIdentifier("com.example.loadimage:drawable/" + imageFilename, null, null);

參考解答



如何作出翻⾴效果?

使⽤ViewFlipper



ViewFlipper

• ViewFlipper可以在Activity中，顯⽰不同
的ViewGroup

• 加入的View即可透過ViewFlipper的
showNext()與showPrevious()即可切換不
同的View



• Transitions > ViewFlipper
新增ViewFlipperClass專案

刪除多餘的檔案與程式內容後加入ViewFlipper



加入3個ImageView，fill_parent、



public class MainActivity extends Activity {
private ViewFlipper myViewFlipper;

@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

//取得ViewFlipper
myViewFlipper=(ViewFlipper) findViewById(R.id.viewFlipper1);
//設定touch事件
myViewFlipper.setOnTouchListener(myViewFlipperListener);

}

OnTouchListener myViewFlipperListener= new OnTouchListener() {

@Override
public boolean onTouch(View v, MotionEvent event) {

// TODO Auto-generated method stub
myViewFlipper.showNext();
return false;

}
};

}

設定onTouch事

點擊就show出下⼀張



執⾏結果



⼿勢偵測
GestureDetector

本範例參考 PCuSer電腦⼈Android App 開發者必修16堂課 趙令⽂ Brad



使⽤⾃定⼿勢偵測步驟

• 建立⾃⼰的Detector Listener，才可⽤於整合⽬
前動作⾏為(ViewFlipper.showNext())

• 產⽣Listener實體

• 產⽣Gesture實體並指定Listener

• 將原本的Touch事件委託給⾃定的Listener

• 注意! onDown必須override並return為true，才
可繼續onFling動作



private class MyGDListener extends GestureDetector.SimpleOnGestureListener{

@Override
public boolean onDown(MotionEvent e) {

return true; //return true才能讓onFling作⽤
}

@Override
public boolean onFling(MotionEvent e1, MotionEvent e2, float velocityX,

float velocityY) {

if(velocityX < -10)
myViewFlipper.showNext();

else if(velocityX > 10)
myViewFlipper.showPrevious();

return super.onFling(e1, e2, velocityX, velocityY);
}

}

⾃定

⾃定Listener是為了能夠存取myViewFlipper變數



protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

//取得ViewFlipper
myViewFlipper=(ViewFlipper) findViewById(R.id.viewFlipper1);
//設定touch事件
myViewFlipper.setOnTouchListener(myViewFlipperListener);
//產⽣Listener實體
MyGDListener myGDListener=new MyGDListener();
myGestureDetector=new GestureDetector(this, myGDListener);

}

產⽣Listener實體

產⽣Detector實體並指定Listener

OnTouchListener myViewFlipperListener= new OnTouchListener() {

@Override
public boolean onTouch(View v, MotionEvent event) {

return myGestureDetector.onTouchEvent(event); //將事件處理委託給myGestureDetector
}

};

onTouch動作時，交由Detector處



如果我要加入很多⾴
呢?

動態產⽣ImageView



移除ImageView，ViewFlipper設定id

移除ImageView

記得id，我們才知道要加到哪個View



protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

//取得ViewFlipper
myViewFlipper=(ViewFlipper) findViewById(R.id.viewFlipper1);
//設定touch事件
myViewFlipper.setOnTouchListener(myViewFlipperListener);
//產⽣Listener實體
MyGDListener myGDListener=new MyGDListener();
myGestureDetector=new GestureDetector(this, myGDListener);

}

ImageView myImage1= new ImageView(this);
myImage1.setImageResource(R.drawable.news1);
myViewFlipper.addView(myImage1);

透過new ImageView產⽣實體，再加
到myViewFlipper裡⾯



     @Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

//取得ViewFlipper
myViewFlipper=(ViewFlipper) findViewById(R.id.viewFlipper1);
//設定touch事件
myViewFlipper.setOnTouchListener(myViewFlipperListener);
//產⽣Listener實體
MyGDListener myGDListener=new MyGDListener();
myGestureDetector=new GestureDetector(this, myGDListener);

}

int []myImageResource={R.drawable.news1,R.drawable.news2,R.drawable.news3};

for (int i=0;i<3;i++)
{

ImageView tmpImageView=new ImageView(this);
tmpImageView.setImageResource(myImageResource[i]);
myViewFlipper.addView(tmpImageView);

}

設定⼀個Resource的陣列

⽤迴圈動態新增ImageView到myViewFlipper



已完成



ListView探討 
(iOS的TableView)



ListView

• ListView相當於iOS的TableView

• 使⽤ListView必須透過Adapter(介⾯)完成資料設定

• ListView也有內建的Layout，讓使⽤者可以快速的
呈現資料

• 常搭配ArrayList (可視為iOS的NSMutableArray)

• 常搭配HaspMap<key,value> (可視為iOS的
NSMutableDictionary)



BaseAdapter是抽象類別(Abstract)，需要被繼承使⽤，但是彈性最⼤

• 需要覆寫四個⽅法

• int getCount() //row總個數

• Object getItem(int position)  //此row的資料

• long getItemId(int position)  //此row的id

• View getView(int position, View view, ViewGroup parent) //cell view



ListView產⽣步驟
• 先拉⼀個ListView元件並取得此元件

• 建立⾃⼰要呈現的Cell View

• 建立繼承BaseAdapter的Class

• 在Class傳入(建構⼦)以下資訊:

• 1. Context(上下⽂)，⽤以產⽣LayoutInflater

• 2. 顯⽰資料

• 實現BaseAdapter需要產⽣的四個⽅法

• 採⽤LayoutInflater取得⾃定的Cell View並回傳

• 建立ListView和Adapter的關係



Composite > ListView



private ListView myListView;

myListView=(ListView)findViewById(R.id.listView1);

1

2

取得ListView

建立⾃定的Cell. 



加入⼀個TextView即可



繼承BaseAdapter

按左件後> Add unimplemented methods，⾃
動產⽣需要實現的⽅法



private class MyBaseAdapter extends BaseAdapter{

@Override
public int getCount() {

// TODO Auto-generated method stub
return 0;

}

@Override
public Object getItem(int arg0) {

// TODO Auto-generated method stub
return null;

}

@Override
public long getItemId(int arg0) {

// TODO Auto-generated method stub
return 0;

}

@Override
public View getView(int arg0, View arg1, ViewGroup arg2) {

// TODO Auto-generated method stub
return null;

}

}

⽬前沒有任何資訊可以這些⽅法結合

需要的資訊有: 1. 資料來源 2. 作出View的資訊

需要Context來做出View⾃⼰定義的資料結構



如何取得⾃⼰的
CellView?

1. 實現LayoutInflater物件，此物件可由

2 由LayoutInflater.inflate⽅法取得⾃定cell view的layout



private class MyBaseAdapter extends BaseAdapter{

private String[] myData;
private LayoutInflater myLayoutInflater;

//利⽤建構⼦來作資料初始化
public MyBaseAdapter(String[] data, Context context) {

myData=data;
myLayoutInflater=LayoutInflater.from(context);

}

...

...
}

建構⼦不回傳東⻄

名稱與類別名稱相同

透過建構⼦初始化Data及LayoutInflater



class 類別名稱 {
存取權限 類別名稱(型別 參數, ..)  {
   ...
  }
}

建構⼦語法



@Override
public int getCount() {

return myData.length;
}

@Override
public Object getItem(int position) {

return myData[position];
}

@Override
public long getItemId(int position) {

return position;
}

實現⽅法getCount、getItem、getItemId

實現⽅法getView

@Override
public View getView(int position, View contentView, ViewGroup parent) {

if(contentView==null)
contentView=myLayoutInflater.inflate(R.layout.my_cell_view, null);

return contentView;
}



建立ListView和Adapter的關係

private ListView myListView;
private String[] data={"Book1","Book2","Book3"}; //設定資料
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

myListView=(ListView)findViewById(R.id.listView1);
MyBaseAdapter adapter=new MyBaseAdapter(data, getBaseContext());//新增MyBaseAdapter
myListView.setAdapter(adapter); //建立與ListView關係

}

建立ListView和Adapter關係

新增⾃⼰資料



執⾏結果(尚未把資料填入⾃定Cell View)



@Override
public View getView(int position, View contentView, ViewGroup parent) {

if(contentView==null)
contentView=myLayoutInflater.inflate(R.layout.my_cell_view, null);

return contentView;
}

              //contentView就是我們設定的Cell View
TextView bookName=(TextView)contentView.findViewById(R.id.textView1);
String bookNameString=myData[position];
bookName.setText(bookNameString);

由contentView的findViewById找
到對應的View並作設定

(執⾏結果)



為ListView加上item選擇動作
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

myListView=(ListView)findViewById(R.id.listView1);
MyBaseAdapter adapter=new MyBaseAdapter(data, getBaseContext());//新增MyBaseAdapter
myListView.setAdapter(adapter); //建立與ListView關係

myListView.setOnItemClickListener(itemClickListener);
}

};

OnItemClickListener itemClickListener=new OnItemClickListener() {

@Override
public void onItemClick(AdapterView<?> parentView, View view, int position,

long arg3) {

}



採⽤Toast做訊息提⽰

• Toast可以在螢幕上彈出⼀段訊息

• 最簡單的⽤法，Class的⽅式

• Toast.makeText(Context,Message,時間長短);

• 最後要⽤show()才會出現



OnItemClickListener itemClickListener=new OnItemClickListener() {

@Override
public void onItemClick(AdapterView<?> parentView, View view, int position,

long arg3) {

}

Toast.makeText(view.getContext(), "Row Index is"+position, Toast.LENGTH_SHORT).show();

加在onItemClick裡⾯

透過+即可連接字串

時間設定為短

show才會顯⽰

java的與法中，可以⽤「.」來串接⽅法



(執⾏結果)

Example: ListView+BaseAdapter



Exercise: 請作出以下的layout

2個圖片

(執⾏結果)

圖片先⽤ic_launcher.png



⼀個
Row有兩個

ImageView，如何區

利⽤setTag與getTag



MyListener listener = new 
MyListener();      
button1.setTag(1);      
button1.setOnClickListener(listener);     

View.OnClickListener {      
     
        @Override     
        public void onClick(View v) {      
            int tag = (Integer) v.getTag();      
 
        }     

設定Tag為1

在Listener的時候透過View v取得tag



Exercise: 點擊不同的圖顯⽰不同的數字

10

2 3

4 5



@Override
public View getView(int position, View contentView, ViewGroup parent) {

if(contentView==null)
contentView=myLayoutInflater.inflate(R.layout.my_cell_view, null);

column1ImageView=(ImageView)contentView.findViewById(R.id.imageView1);
column2ImageView=(ImageView)contentView.findViewById(R.id.imageView2);

column1ImageView.setTag(position*2);
column2ImageView.setTag(position*2+1);

column1ImageView.setOnClickListener(myImageClickListener);
column2ImageView.setOnClickListener(myImageClickListener);

return contentView;
}

private OnClickListener myImageClickListener=new OnClickListener() {

@Override
public void onClick(View view) {

int tag=(Integer) view.getTag();
Toast.makeText(view.getContext(), "current Tag is: "+tag, Toast.LENGTH_SHORT).show();

}
};

getView改寫後

相對應的Listener



執⾏結果，已經可以針對不同的Click做相對應的動作



圖片瀏覽、滑動切換
Done

ListView
Done!

透過Activity傳參數
Done!

你應該會了...



資料來源呢?



1 . 取得所有書城上的分類 ( 可以直接把網址貼到瀏覽器做測試 ) 
         
        http://images.memobook.com.tw/m/api.php?act=memo_list 
         
        參數說明： 
        act => 呼叫 API 的類型 

        JSON 回傳格式說明： ( 無筆數限制 ) 
        [ 
            { "id" : 分類編號 , "title" : 分類標題 , "counts" : 該分類的書籍量 , "icon" : 代表的 ICON , "icon_bg" : 該項⽬的背景圖片 } ,  
            { "id" : 分類編號 , "title" : 分類標題 , "counts" : 該分類的書籍量 , "icon" : 代表的 ICON , "icon_bg" : 該項⽬的背景圖片 } ,  
            { "id" : 分類編號 , "title" : 分類標題 , "counts" : 該分類的書籍量 , "icon" : 代表的 ICON , "icon_bg" : 該項⽬的背景圖片 } ,  
            ...... 以此類推 
        ] 

    另外關於測試⽤的 API 網址如下： 
    http://images.memobook.com.tw/sample/api.php

查看Memobook提供的API

http://images.memobook.com.tw/m/api.php?act=memo_list
http://images.memobook.com.tw/sample/api.php


採⽤OpenSource
Android Asynchronous Http Client

http://loopj.com/android-async-http/

http://loopj.com/android-async-http/




安裝步驟

由於加入使⽤INTERNET要求，必須在
AndroidManifest.xml設定使⽤權限



<?xml version="1.0" encoding="utf-8"?>
<manifest xmlns:android="http://schemas.android.com/apk/res/android"
    package="com.example.memobook_mainpageapi"
    android:versionCode="1"
    android:versionName="1.0" >

    <uses-sdk
        android:minSdkVersion="14"
        android:targetSdkVersion="19" />

    <application
        android:allowBackup="true"
        android:icon="@drawable/ic_launcher"
        android:label="@string/app_name"
        android:theme="@style/AppTheme" >
        <activity
            android:name="com.example.memobook_mainpageapi.MainActivity"
            android:label="@string/app_name" >
            <intent-filter>
                <action android:name="android.intent.action.MAIN" />

                <category android:name="android.intent.category.LAUNCHER" />
            </intent-filter>
        </activity>
    </application>

</manifest>

<uses-permission android:name="android.permission.INTERNET" />

加入INTERNET使⽤權限

AndroidManifest.xml
建立專案名稱為:Memobook_MainPage+API



將檔案拖曳到libs

選擇Copy files

多了⼀個android-async-

jar檔案加入libs



package com.example.memobook_mainpageapi;

import android.app.Activity;
import android.os.Bundle;

public class MainActivity extends Activity {

@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

}

}

import com.loopj.android.http.*;

import後使⽤



如何加入參數

使⽤步驟



        http://images.memobook.com.tw/m/api.php?act=memo_list觀察API：
(Get⽅式)
有⼀個參數 Key=”act” Value=”memo_list”

產⽣參數

http://images.memobook.com.tw/m/api.php?act=memo_list


Get⽅法中，我們需要url，params以及回傳結果



提供的JSON回傳範例，⽤
JsonHttpResponseHandler



@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

AsyncHttpClient client = new AsyncHttpClient();
RequestParams params= new RequestParams("act","memo_list");

client.get("http://images.memobook.com.tw/m/api.php", params, new JsonHttpResponseHandler()
{

@Override
public void onSuccess(JSONArray response) {

try {
JSONObject eachRow=response.getJSONObject(0);

String iconbg=eachRow.getString("icon_bg");

System.out.print(eachRow);
} catch (JSONException e) {

e.printStackTrace();
}
super.onSuccess(response);

}

});

}

⽤JSON格式回傳

取得其中⼀個JSON Object

取得JSON回傳程式碼 

取得對應Key的Value



執⾏結果

取得回傳



如何下載圖片?



採⽤OpenSource
Android Universal Image Loader

https://github.com/nostra13/Android-Universal-Image-Loader

https://github.com/nostra13/Android-Universal-Image-Loader






安裝⽅式



專案Memobook_MainPage+API+Loadimage

加入libaray universal-image-loader-1.9.2.jar



提供設定選項



提供顯⽰選項



使⽤⽅式

1. 設定displayImageOptions

2. 設定

3. 使⽤⽅法
imageUrl:網址
imageView:被顯⽰的ImageView



//變數宣告
DisplayImageOptions options;
ImageLoader imageLoader = ImageLoader.getInstance();

// 1. 設定display option
        options = new DisplayImageOptions.Builder()
            .showImageForEmptyUri(R.drawable.ic_launcher) //若網址不存在的圖片
        .showImageOnFail(R.drawable.ic_launcher) //若載入錯誤的圖片

.cacheInMemory(true) //⽤記憶體暫存

.cacheOnDisk(true) //存在本機

.build();
        
        //2. 設定imageLoaderConfiguration
        ImageLoaderConfiguration config = new ImageLoaderConfiguration.Builder(getBaseContext())

    .defaultDisplayImageOptions(options) //設定內定的display option
    .build();

        
        imageLoader.init(config); //初始化

在原本的專案加入步驟1和步驟2



拉⼀個ImageView⽤來做網路下載圖片的顯⽰

imageLoader.displayImage(iconbg,myImageView);

步驟3

得到的網址

被改變的ImageView



protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);

myImageView=(ImageView) findViewById(R.id.imageView1);
//變數宣告
DisplayImageOptions options;
final ImageLoader imageLoader = ImageLoader.getInstance();

// 1. 設定display option
        options = new DisplayImageOptions.Builder()
            .showImageForEmptyUri(R.drawable.ic_launcher) //若網址不存在的圖片
        .showImageOnFail(R.drawable.ic_launcher) //若載入錯誤的圖片

.cacheInMemory(true) //⽤記憶體暫存

.cacheOnDisk(true) //存在本機

.build();
        
        //2. 設定imageLoaderConfiguration
        ImageLoaderConfiguration config = new ImageLoaderConfiguration.Builder(getBaseContext())
    .defaultDisplayImageOptions(options) //設定內定的display option
    .build();
        
        imageLoader.init(config); //初始化
    

}

//取得JSON Response
AsyncHttpClient client = new AsyncHttpClient();
//設定參數
RequestParams params= new RequestParams("act","memo_list");
//使⽤get⽅式
client.get("http://images.memobook.com.tw/m/api.php", params, new JsonHttpResponseHandler()

{

@Override
public void onSuccess(JSONArray response) {

// TODO Auto-generated method stub
try {

JSONObject eachRow=response.getJSONObject(0);
String iconbg=eachRow.getString("icon_bg");
//3. 設定要顯⽰的圖片
imageLoader.displayImage(iconbg,myImageView);

} catch (JSONException e) {
// TODO Auto-generated catch block
e.printStackTrace();

}
super.onSuccess(response);

}

});

完整程式碼

inner class的變數要加final，避免被改變



執⾏結果

專案Memobook_MainPage+API+Loadimage



Exercise: 請整合
ListView+BaseAdapter+ImageLoader+AP

只有單個欄位沒其他按鈕 2個圖片個別帶出資料



提⽰: API CallBack後才把ListView的Adapter設定好

client.get("http://images.memobook.com.tw/m/api.php", params, new JsonHttpResponseHandler()
{

@Override
public void onSuccess(JSONArray response) {

myPage1Adapter adapter=new myPage1Adapter(getBaseContext(), response);
myListView.setAdapter(adapter);

super.onSuccess(response);
}

});

步驟1. 建立繼承BaseAdapter的class

步驟2. 初始設定ImageLoader

步驟3. 設定網路API回傳資料

步驟4. 在獲得資料後設定ListVIew的Adapter

步驟0. 建立cell的Layout



專案Memobook_MainPage+ListView+BaseAdapter+ImageView

執⾏結果



Exercise: 請完成此專案

.使⽤ListView+BaseAdapter

.使⽤ImageLoader

.使⽤Async Http Request

.傳遞單列參數

.傳遞雙欄參數

.Activity資料傳遞



2 . 取得某⼀分類裡⾯的相片書列表 

        http://images.memobook.com.tw/m/api.php?act=memo_class&id=10 

        參數說明： 
        act  => 呼叫 API 的類型 
        id    => 分類編號 ( 從前⼀個 API 取得 ) 

        JSON 回傳格式說明： ( 無筆數限制 ) 
        [ 
            {"id" : 書籍編號 ,"img" : 書籍縮圖網址 ,"title" : 書籍標題 ,"anthor" : 作者姓名 } , 
            {"id" : 書籍編號 ,"img" : 書籍縮圖網址 ,"title" : 書籍標題 ,"anthor" : 作者姓名 } , 
            {"id" : 書籍編號 ,"img" : 書籍縮圖網址 ,"title" : 書籍標題 ,"anthor" : 作者姓名 } , 
            ...... 以此類推 
        ] 

http://images.memobook.com.tw/m/api.php?act=memo_class&id=10


    3 . 取得某⼀書籍的詳細內容及相片書圖片 

        http://images.memobook.com.tw/m/api.php?act=memo_detail&id=318 

        參數說明： 
        act  => 呼叫 API 的類型 
        id    => 書籍編號 ( 從前⼀個 API 取得 ) 

        JSON 回傳格式說明： ( 只有⼀筆 ) 
        { 
            "details":{ 
                "id"           :  書籍編號 , 
                "title"        :  書籍標題 , 
                "anthor"     : 作者姓名 , 
                "img"         : 書籍縮圖網址 , 
                "content"   : 書籍說明內容 
             }, 
             "imgs":[  
                "http://www.memobook.com.tw/saved/14/140324/14032415240219/thumb/p1_5ObDvl_1.jpg", 
                "http://www.memobook.com.tw/saved/14/140324/14032415240219/thumb/p2_yLkgAa_0.jpg", 
                "http://www.memobook.com.tw/saved/14/140324/14032415240219/thumb/p3_byYlN2_5.jpg", 
                ...... 上⾯列表是圖片位置 ( ⽂字 ) , 以此類推 ( 有多少⾴就會撈多少⾴ ) 
             ] 
        } 
        

http://images.memobook.com.tw/m/api.php?act=memo_detail&id=318
http://www.memobook.com.tw/saved/14/140324/14032415240219/thumb/p1_5ObDvl_1.jpg
http://www.memobook.com.tw/saved/14/140324/14032415240219/thumb/p2_yLkgAa_0.jpg
http://www.memobook.com.tw/saved/14/140324/14032415240219/thumb/p3_byYlN2_5.jpg


恭喜!你已經可以完成此專案!

• 圖片載入(ImageView)

• 圖片滑動變換 (利⽤ViewFlipper)

• ListView (iOS的TableView)

• ListView Cell⾃定layout

• ListView Cell傳遞資料並加入動作



Tips



Tip: 顯⽰⾏號



⾃動完成 

or Alt+/



設定編碼為UTF-8



顯⽰繼承架構



存入Snippets



使⽤Snippets



• http://goo.gl/iwnL4Y
下載使⽤資料

3張圖以及2個opensource

http://goo.gl/iwnL4Y

